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1. Introduction
 

 

 

EQUINOX-3D is a powerful 3D modeling / CAD (computer aided design), animation and
rendering software suite.
It allows you to create stunning, photorealistic pictures and movies, to design complex
mechanical  parts  and  intricate shapes  for  3D printing,  laser cutting,  or  other  types  of
manufacturing, and to test mechanical designs, to build 3D worlds for virtual reality, or for
many other applications, and so on.
The possibilities are endless!
EQUINOX-3D also has a powerful application programming interface (API), so entire
new functionality may be added from “plugins”.

Font conventions
When referring to a menu item or a button / icon on a panel, or in a dialog box, bold, italic
sans-serif font is used, with the following conventions:

- Menu->File->Open file means the “Open file” menu button in the horizontal menubar's
"File" menu.

-  Menu->Transform->Reset means the “Reset” menu button in the vertical menubar's
"Transform" menu.

- Tool->Surface->Revolve  means the “Revolve” button / icon in the tool panel's (toolbar)
"Surface" folder.

Ctrl+H (bold, sans-serif) means a keyboard shortcut.

3DWindow, Spline, Mesh etc.: fundamental types are capitalized and contracted into a
single word.
For those of you, interested in developing plugins for EQUINOX-3D: these also refer to
actual data types in the API (E3dWindow, E3dSpline, E3dMesh etc.).

Helpful tips are marked with Tip: (bold italics, serif).
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1.1. User inteface basics
 

 

 

EQUINOX-3D starts up with a traditional 4-view look, which may be customized later.

All buttons, sliders etc. have tool-tips. These help messages pop up if you rest the mouse
pointer on the button for 2 seconds or longer.

Tip: Reading the tool-tips is a quick and easy way to get started with EQUINOX-3D!

There is also a vertical menu panel on the left, a “Transformation and search” panel on the
right and 3 horizontal panels on the bottom.
Each of the above may be turned on or off, from the View menu, or via the function keys
F1-F5.

         Figure 1.1.: the main window of EQUINOX-3D
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1.1.1. 3D windows
 

 

 

Each 3D window (3DWindow) has a header with some controls and a main part with the
3D display. You can turn this header on/off via the H key.

Figure 1.1.1: a 3DWindow with Perspective view and Wireframe display mode (renderer).

The active 3DWindow is where the mouse pointer is. Keyboard input for camera control,
selection etc. will apply in the active window.

Each 3DWindow may be minimized / maximized either horizontally, vertically, or in both
directions, by clicking the window icon on the righ side of the header (see the tool-tip).
You can also change the size of each window by hitting the F8 key.

New, “detached” 3DWindows may also be opened via  Window->New 3D window,  or
with Shift+Ctrl+N.
Detached  3DWindows  will  have  their  own  Cameras.  When  you  create  a  detached
3DWindow, a new Camera is created for it, called “Detached-Camera”, but you can also
share any other cameras between 3DWindows.

Both the main 3DWindow and detached ones may be switched to full-screen mode via the
View menu, or with Ctrl+F.

To access the settings specific to a 3DWindow, press the settings button in the middle of
the header.
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1.1.1.1. Using VR or AR headsets with EQUINOX-3D
 

 

 

EQUINOX-3D supports VR (virtual reality), and AR (augmented reality) headsets.  You
may set up any detached 3DWindow, as your VR headset display.
To do this,  make the 3DWindow full-screen with Ctrl+F and simply move it over to the
headset's  screen  (e.g.  drag  with Alt+left  mouse  button,  depending on  your  computer's
desktop settings). See your graphic card's settings (e.g. nvidia-settings) for using multiple
display setups, such as connecting a VR headset.

Headset-specific  parameters  (split-screen  horizontal  stereo  3D,  eye  distance,  lens
correction etc.)  can be  adjusted in the  3DWindow's settings.  These will  be  saved and
restored when you save a 3D scene to a file, so you don't need to set them up again.

The headset's tracking sensor (or any 3D sensor) can be connected to the 3DWindow's
Camera. You can turn any Model into a 3DSensor from Constraints->Make a Model a
3D sensor. This Model will be able to drive either Cameras, or any other 3D Models, via
transform constraints (see later). Multiple 3DSensors allow you to track your hands as
well, or even your entire body (sensor support is still under development).
This setup is saved into Scene files as well and sample setups will be provided.
Headset tracking / Camera control may be turned on / off by pressing Ctrl+Enter while the
pointer is on the given 3DWindow (other sensors will have their own settings under the
appropriate 3DSensor object).
When tracking / Camera control is turned off, the usual Camera controls will work instead
(see 1.2.1).

Figure 1.1.1.1 using EQUINOX-3D with a VR headset.
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1.1.1.2. View-mode and Rendering-mode
 

 

 

The top-left button of each 3D window activates a pull-down menu of choices for the
view-mode.

Any of the 3DWindows may be set to one of these view-modes:
– Perspective - standard 3D view with a perspective or custom projections
– Top, Front, Right - “orthographic” projection
– Schematics - shows the relationships between objects as a graph
– Animation - animation curves
– Texture - texture-mapping view
– Any other custom views that may be implemented by plugins

Figure 1.1.1.1a view-modes in a 3D window

The second button from the right activates the menu for selecting the  rendering mode,
such as Wireframe (Wire+Z), Hidden line, or Ray-tracer, etc.

Figure 1.1.1.1b different rendering-modes in a 3DWindow
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EQUINOX-3D has a unique and very powerful  deep-integration renderer infrastructure.
Plugins can implement new renderers and any 3D window can then use those renderers
while still displaying selections, wireframe, 3D controls etc. and allowing editing in that
window.
In other words, plugins can add fully integrated renderers to EQUINOX-3D.
Yes, you can edit your 3D model right on a photorealistic, ray-traced view!

For example “Cg” and “Ray-tracer” renders are implemented by plugins, while “Wire-
frame, Hidden-line etc. are built in.

Also, EQUINOX-3D has a fast interactive ray-tracer, so you can edit your 3D models
directly in a ray-traced window with physically correct shading, reflections, refractions etc.
changing as you change a shape!

Tip:  clicking  the  the  Middle  Mouse  Button  (MMB)  on  either  the  view-mode  or  the
rendering  mode  buttons  will  toggle  between the  two  most  recent  modes.  This  makes
switching back-and-forth super quick!
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1.1.2. Bottom panels
 

 

 

On the bottom of the main window, there are 3 panels (bars). These panels can be turned
on and off from Menu->Panels or via the keys F1-F5.

1.1.2.1. Toolbar
 

 

 

The Toolbar is organized into folders. (Light,  Create,  Surface etc.). The folders can be
opened and closed by clicking on the little green arrow after the folder's name:

Clicking on an icon with the LMB (Left Mouse Button) will activate a tool, while the RMB
(Right Mouse Button) will bring up the tool's dialog box, if that particular tool has one
(and possibly activate the tool).
For example: LMB on the Tube icon will simply create a “default” Tube, while  RMB  will
also pop up the “Create Tube” dialog box and let you interactively change the parameters
of the Tube (inner radius, outer radius, height etc.).

1.1.2.2. Status panel
 

 

 

The Status panel has a message label, undo-stack indicator bar and a time code display for
animaton.
The  message  label  indicates  the  status  of  EQUINOX-3D,  the  function  of  the  mouse
buttons, it can display messages and/or a progress-indicator bar.

Tip: The Status panel is the primary source of feedback to the user. regarding the current
status / mode EQUINOX-3D and what the mouse buttons will do.
When in doubt, read the status panel!

In this manual, and in EQUINOX-3D in general (e.g. on the Status panel),
 LMB, or just R means Left Mouse Button
 MMB, or just M means Middle Mouse Button
 RMB, or just B means Right Mouse Button
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1.1.2.3. Time panel
 

 

 

The Time-panel includes the main time slider with the current-, start- and end-frame fields
and the usual playback buttons (rewind, stop, play etc).
This panel is used for controlling and displaying (playing) animations.
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1.1.3. Menus
 

 

 

There are two menu-bars in EQUINOX-3D. The horizontal one on the top has the standard
"File" menu, user interface options, preferences etc.

The vertical menu-bar on the left has the 3D modelling, rendering and animation menus:

This menubar is configurable in the Preferences settings. The buttons can be displayed
either with Icons only, Text only or both Icons and Text.
You can find the setting for this, under  Menu->Preferences->Edit, (“Menubar buttons”
under the User interface drop-down folder):

Figure 1.2.1. Vertical menu bar with Icon only, Text only, and Text and icons setting.
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Buttons in these menus may have an "options” "sub-button". This pops up the a dialog box
for a particular tool (similarly to "right-clicking" on a ToolPanel icon).
The Clone->Immediate button is an example of this. See Figure 1.2.2.

Figure 1.2.2. Menu button with options (dailog box) “sub-button”

Tip: Clicking on any menubar button (File,  Display and so on) with the Middle Mouse
Button, will activate the last function again. This can really speed up your workflow.

Note: plugins can add buttons in either the menus and / or the Toolbar. You can unload,
modify  /  rebuild  (if  you  can  code  in  C/C++)  and  reload  a  plugin  without  exiting
EQUINOX-3D. When a plugin is unloaded, those buttons are removed, when it's reloaded,
the buttons are added back.
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1.1.4. Transform Panel  

 

 

This vertical  panel  is  used  for  interactive transforming (scaling,  rotating,  moving etc.)
objects or components of objects.
It controls the way objects are manipulated with the mouse.

This panel is inactive (left image) when there are no objects
selected.
If  an  object  is  selected,  the  panel  becomes  active  (right
image) and shows the current transformation values as well
as the name of the selected object(s).

You  can  enable/disable  interactive  transformations  per
coordinate axis (X, Y, Z) with the little buttons right to the
number fields.
You can also turn them on/off simultaneously by clicking on
the “Scaling”, “Rotation” or “Translation” buttons, or hitting
the 'X', 'C' or 'V' keys.

Under  the  label  “What”,  you  can  select  what  will  be
transformed with the mouse (“transform target”):
- Mdl: whole object(s) (Models), or
- Tag: tagged points of objects

Under the “How” label, you can select how the interactive
translating will work (“transform mode”):
- View: drag objects or components along the view
- Lcl:  move along X, Y or Z axis of an object

There is also an interactive finder tool on this panel. If you type in a name, or a partial
name using the “*” wildcard character, it will select objects that match that name.

If the transform target is Tag, but there are no tagged points on the selected objects, it will
temporarily switch to Mdl (while the transforming is taking place; holding down a mouse
button).
This allows for quick switching between transforming objects or points, just by tagging and
un-tagging points.



19 

1.2. User interaction
 

  

 

1.2.1. Transient modes
 

 

Many modes in EQUINOX-3D are only active while you are holding down a key. When
you release that key, it will go back to the previous mode.
This greatly speeds up your work flow, as you don't have to run back-and-forth between
the menu and 3DWindows.
The status panel will always tell you what mode is active.

For example, holding down the M key allows you to move points, such as Mesh Vertices,
or Spline CVs, holding down the Ctrl key allows you to move the Camea, and so on.
When you let go of the key, it will go back to whatever mode you were in.

1.2.2. Context-sensitivity
 

 

 

EQUINOX-3D is very powerful, with a lot of functionality. Don't let the relatively simple-
looking user interface deceive you!
It looks simple, because most functionality is context-sensitive, meaning that you are only
offered options that make sense, in any given situation.
For example, when you activate the Edit Polygons tool, you can do all your editing very
quickly and efficiently without using any menus.
As you move the mouse pointer over the Mesh or PolyGroup you have selected, the Status-
panel  will  show  you  options,  based  on  where  the  mouse  pointer  is,  and  the  active
component will be highlighted.
For example, if it's above a Vertex, the Vertex will be highlighted (it will turn yellow), and
it will let you delete that Vertex, start a new Polygon, or a new Edge at that Vertex, etc.
If the pointer is above an Edge, the Edge will be highlighted (it will turn yellow), and it
will allow you to add a new Vertex on the Edge (“split Edge”), delete the Edge.
And so on...
This speeds up the work flow even more and it keeps the user interface simple and easy to
learn (much simpler than a bunch of pop-up menus, to show all the options).
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1.3. 3D interaction
 

 

 

1.3.1. Cameras
 

 

 

The first and most important thing to learn in any 3D software, is controlling the Camera.
When you connect a VR headset to EQUINOX-3D, the virtual Camera in EQUINOX-3D,
will simply follow your head movements.
On a traditional monitor, however, you will be looking at a 2D screen, so you need to
control the Camera with the mouse (or other device).
Each 3DWindow's has its own, independent Cameras for each view-mode (Top, Front,
Perspective, etc.).
The “Perspective” view Camera of each 3DWindow is shown in the schemaitics view, as a
simple hierarchy, with the Camera's transform-node, an aim-point, and a common parent
node.
You  can  create  any number  of  Cameras,  you  can  switch  any 3DWindow to  use  any
Camera, by clicking the “Camera” button in the 3DWindow's header.
You can even share Cameras between 3DWindows. For example, you may want to see the
Scene from the same Camera view, in wireframe mode and ray-tracer mode, side-by-side,
in two separate 3DWindows.
You can also see the Cameras themselves in the 3DWindows, if you select the appropriate
node in the schematics view, and un-hide it (e.g. via Menu-Display->Un-hide selected).

1.3.2. Camera control
 

 

 

To ease the transition from other 3D packages, EQUINOX-3D implements the camera
control of some popular 3D programs, as well as its own.
All the modes below are transient modes. Releasing the given key will put EQUINOX-3D
back in the previous mode (e.g. rotating objects).

Orbit: While holding down the O key on a perspective view, you can 'orbit'
the Camera around its aim point, with the mouse.
LMB: longitude+latitude     MMB: longitude     RMB: latitude

Dolly: While holding down the  P key on a perspective window, you can
move the Camera along the line-of-sight with the mouse (see the
Status panel indications for the mouse button functions).

 
Track/Zoom: While holding down the Z key on a perspective view, you can move

the Camera and its aim-point parallel to the view plane (tracking) or
you can change Camera's field-of-view (zoom).
On an orthographic view (Top, Front, Right, Schematics, Animation,
Texture etc.), holding down the  Z key will activate Scroll / Zoom
mode.
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Zoom into region: While holding down the Z key on a non-perspective view, you can
select a rectangular region with the right mouse button. When you
release the mouse button, the Camera will 'fly' into that region.
If  you  accidentally  activate  this,  just  release  the  Z key  before
releasing the mouse button, to cancel this action.

1.3.1.2. Single-key camera control
 

 

 

Orbit/Dolly/Track: on a perspective view, while holding down the  Ctrl key,  you can
'orbit',  'dolly'  or  'track'  the Camera by moving the mouse while
holding down one of its 3 buttons.

Scroll/Zoom/Zoom: on an orthographic view, while holding down the Ctrl key, you can
'scroll', 'zoom' or 'zoom into a region', by moving the mouse while
holding down one of its 3 buttons.

Orbit/Track/Dolly: hold down the Alt key and see the Status panel...
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1.3.2.3. “Fly to” / Framing things
 

 

 

When working on an object, we usually need to move the Camera, so the object is in the
middle of a window and zoom in on it: i.e. "frame" the object.
EQUINOX-3D has a sophisticated automatic framing feature. In a perspective window, it
can frame an object or objects by not just putting it in the center of the window and getting
close enough to it, but it also places the camera's aim point at a reasonable center point
around which you can orbit the camera and keep the object(s) in the center.
This allows you to easily examine the object from different angles.

EQUINOX-3D takes this feature a step further: instead of immediately placing the cameras
to their new positions and orientations, it smoothly “flies” them there.
The framing/fly-to function works in any view (3D, schematics, animation curcves etc.).
This helps you maintain a sense of  relative location of  objects and it provides a more
pleasant user experience.
Similar techniques are common in video games, but EQUINOX-3D is the only modeler  to
support it (since the last edition of this manual, some modelers partially copied this feature,
but only for 3D views).

You can adjust the duration of the fly-to under Menu->Camera->Settings.

Pressing the F key will frame the camera to the selected object(s) in the active 3DWindow.
A will frame the camera to all objects in the Scene.
F or A with Shift will perform the fly-to in all 3DWindows simultaneously.

"Frame selection" works for Models (transform Nodes), Geometries (Meshes, Splines etc.),
PolyGroups or even for a group of selected Polygons.
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2. The 3D world
 

 

2.1. Objects and Models
 

 

 

EQUINOX-3D has two fundamental 3D elements: Object and Model

Objects represent:
– Lights
– Cameras
– Geometries (3D shapes)
– Special elements defined by plugins. For example: force-fields

Models “bring” Objects into the 3D scene, at a specified position, orientation and size
(scale). The 3D industry calls this instantiating or instancing Objects.
Models define the transformation (scaling, orientation (rotation) and position) of Objects,
so they are also called  transformation-nodes, or transform-nodes.
On the schemaitics view, Models are shown as blue boxes with a coordinate-system icon.
Objects are shown as a torqoise box with angled sides and a little icon.

When you create an Object (e.g. by clicking on an icon on the tool panel), EQUINOX-3D
will automatically create a Model for it and place it at the origin.
It will also name them: the Model will have the name of the tool that created it, starting
with a capital letter and the Object will have the same name starting with a lower-case
letter:

Figure 2.1. Schematics-view and 3D-view of a Model with an Object (torquoise box).
Note the coordinate system icon on the Models (blue boxes), representing transformation
and the wireframe cube icon on the “box” Object, indicating a Polygon Mesh.
Similarly,  the “light” Object has a light bulb icon and the “circle” Object has a curve,
indicating a Spline Geometry (not shown on the 3D view).
By default, EQUINOX-3D uses Capitalized names for Models and names starting with
lower-case for Objects (e.g. “extrudeAlongSpline”).
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2.1.1. Multiple instances of an Object
 

 

 

An Object might be added to multiple Models and these Models may be placed, oriented
and scaled differently in the Scene.
This is a powerful and commonly used technique, called “instancing”.
Imagine that you want to build a long hallway with 20 identical columns. If you create 20
duplicates of your column, when you edit one of them, only that one will change.
Instancing it,  on  the other hand,  will  create “links” to  the same Object  from multiple
Models, so if you change one, all instances will change simultaneously.
This will allow you to see your hallway with all 20 columns while you are refining your
column model, but save you the repetitive work of applying every change to all copies.
Instancing is also more efficient because EQUINOX-3D will only have to keep one copy
of the Object in memory, so you can use a lot less memory, if you have many instances of
a complex Object.

Figure 2.2. Schematics view of a duplicated (left) versus instanced (right) Object.
The two situations will look identical on a 3D view, except when you edit the Mesh
called “box-1” in the second case, both of its instances of it will change.
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2.2. Hierarchies
 

 

 

Models  may be  connected  together  to  form hierarchies.  Hierarchies  allow for  relative
transformations, which means that each Model is scaled, rotated and moved relative to its
"parent".
This makes it easy to have a person's upper arm rotate relative to the torso (at the shoulder
joint), the lower arm rotate relative to the upper arm (at the elbow joint) etc.

A hierarchy  is  sometimes  referred  to  as  a  “tree”,  because  its  representation  on  the
Schematics view resembles an upside-down tree. Sub-trees are also called branches.

Figure 2.2. shows an example for a hierarchy.
Note that the branch containing the Models named “Tube”, “Sphere” and “Capsule” is
selected (the edges of the Models are highlighted with white lines).
“Tube” is the root of that branch, while “Box” is the root of the whole hierarchy (tree).

Figure  2.2.  representations  of  a  hierarchy  on  the  Schematics  view  with  vertical  and
horizontal layout and different connector types (left) and the actual 3D shapes (right).
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2.3. Geometries
 

 

 

A Geometry is a type of Object that describes a 3D shape, such as a line, a set of 3D points
(particles), a surface or a volume of a solid, liquid etc.
EQUINOX-3D allows for  multiple Geometries (Mesh,  Spline etc.)  per  transform-node
(Model), so unlike in many other 3D programs, there is usually no need for 'empty' Models
to group Geometries.
This simplifies hierarchies and avoids performing the extra transformations,  leading to
faster rendering. At the same time, it still allows you to easily select and edit Geometries.

2.3.1. Meshes, PolyGroups and Polygons
 

 

 

A Polygon Mesh is a type of Geometry. It is a surface, described by Polygons.
A Mesh has groups of  Polygons that share a Material (a.k.a. Shader). These are called
PolyGroups, or shading-groups.

PolyGroups within a Mesh can share Vertices.
If a Model or a Mesh is selected, its Vertices are shown with little blue rectangles (see
Figure 2.3.1.). If only a Geometry of a Model is selected (not the whole Model), the edges
will be highlighted with cyan, instead of white.
If only a PolyGroup is selected in a Mesh, the Vertices of the Mesh will not be shown.

Figure 2.3.1. A Polygon Mesh with 2 PolyGroups (Grey and Red Polygons).
 The Model selected (left), the Mesh selected (midle), the gray PolyGroup selected (right).

To create a Mesh, you can start from any of the primitives in the Toolbar (Box, Sphere
etc.), then you can use the powerful Polygon editing tools under Menu->Polygons-
>Edit Polygons.
This is a context­sensitive tool that allows you to add/remove Edges, Vertices, 
Polygons, split Edges etc.
Once you activate this tool, just move the mouse over an Edge, Vertex etc. and look at
the Status­panel for instuctions! To exit the Polygon editing too, press the Esc key.
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2.3.2. Subdivision surfaces
 

 

 

Subdivision surfaces are a powerful extension of Polygon Meshes. They are the state-of-
the-art way of modeling complex shapes.
They are perfect for modeling 3D characters, environments, or for the state-of-the-art form
of CAD (computer aided design), called free-form CAD.
If you watch a Pixar movie, or shop around for amazingly complex 3D printed objects,
you will see subdivision surfaces in action.

A subdivision surface takes a low-resolution Polygon Mesh as its input and it smooths the
surface, by applying a subdivision and interpolation process that you can adjust.
As the input is a Polygon Mesh, this allows for  any shape (without having to “stitch”
together pieces), unlike modeling with parametric sufraces, such as NURBS “patches”.
Subdivision surfaces essentially make NURBS patch-based modeling obsolete.

EQUINOX-3D has powerful support for the most advanced form of subdivision surfaces,
called Catmull-Clark subdivision. These allow for nearly any types of Polygons as their
input, unlike other methods, that can only accept triangles.

EQUINOX-3D has robust handling of boundary Edges and Vertices, Edge sharpness and
more. The subdivision “levels” are accessible to the user as separate Meshes under a Model
and each level may be instantiated and/or moved around to other Models.
This is great, if you want to work on the low-res Mesh in one 3DWindow, while seeing the
smooth surface in another window.

        Figure 2.3.2. Smooth subdivision surface (right) with its low-resolution input Mesh (left).
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2.3.2. Splines, Spline Segments and CVs
 

 

 

A Spline is a (usually) curved line that is described by a mathematical formula, using a
parameter, hence their other name: parametric curve.
Splines are usually made of multiple segments. The shape of the segments is determined by
points, called Control Vertices, or CVs.

Interpolating Splines - These Splines go through their control points.

- Linear: Continous segments of straight lines going from one CV to the next:

- Bezier: A very versatile Spline that goes through all of its CVs and the type of the
segments (linear or curved) may be changed individually.
There are 4 CVs for each segment. These are usually represented by 2 lines
(“handles” or “tangents”). These are parallel with the tangent of the curve.

The CVs may have different editing constraints:
– C1-continuity (mirrored handles:  blue). When you move one end of

such a handle,  the other side will  have the same direction (tangent
continuity) and length.

– G1-continuity  (direction-mirrored  handles:  purple).  The  other  side
will keep the same direction, but not the lenght..

– C0-discontinuity (independent handles: cyan)

- Cardinal: A simpler type of Spline that goes through its CVs and has only two CVs
per segment (no "handles").
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Approximating Splines - These Splines don't necessarily go trhough their CVs.

- B-spline: This Spline might not go through its CVs, instead the CVs "pull" on the
curve, like magnets:
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2.3.3. Parametric Faces
 

 

 

The next type of Geometry is called a Parametric Face, or just Face. It is a surface, defined
by closed Splines. Each Spline defines a contour of the Face.
The first Spline defines the exterior contour, while the rest define (optional) holes.
Creating a Face is easy. Just make a Spline, close it and activate Menu->Spline->Convert
to face. See Figure 2.3.1.
Then, you can add further Splines to “cut” holes in the Face, using Menu->Spline->Attach
hole to Face.
You can keep editing the Splines, or you can remove holes, in the Face attributes
dialog   box   (select   the   Face   Geometry   and   press   the   E   key).   You   can   even
instantiate the contour Splines separately (“Split contours” in the  Face attributes
dialog box).

You can mix any types of Splines within a Face. For example, the exterior contour might
be a Bezier Spline, one of the holes a Linear Spline, another one, a B-spline and so on.
Note that the Spline and Face-related functions are all in the Spline menu and there is a
separator before the Face functions.
Faces are very useful,especially when combined with Exture tools.
Appendix A describes all the tools with examples.

 

Figure 2.3.1. Converting a Spline to a Face

Faces with holes are essential for shapes like letters, such as “A”, B”, “D” etc., because
these letters have enclosed holes. See the 3D Text tool in EQUINOX-3D.

Figure 2.3.2. Faces with holes. Note the Bezier curves that specify the contours.
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3. Selecting
 

 

 

EQUINOX-3D has context-sensitive selection and three main selecting modes:
• Model selecting
• Object / Geometry selecting
• Point selecting

3.1. Model selecting
 

 

 

Hold down the SPACE bar:
Information will be displayed in the Status-panel about the Model under the mouse pointer
and the functions of the 3 mouse buttons will be shown (Left button: select Node (single
Model), Middle button: select Branch, Right button: select whole tree (hierarchy) ).

To select multiple Models, hold down the Shift key simultateously with the SPACE bar.

Clicking on 'nothing' while in single selection mode (no Shift key) will unselect everything
in the Scene.
Selected Models are shown with a white wireframe and with points visible (Mesh Vertices,
Spline CVs etc.).

You can also “drag-select” Models, by holding down the  SPACE bar, holding down a
mouse button and moving the mouse to select a rectangular area.

Figure  3.1.1.  Status-panel  when  the  pointer  is  “hovering”  over  an  object,  while  the
SPACE bar is held down.

   Figure 3.1.2. Drag-selecting Models (white wireframe shows that Models are selected).



 32

3.2. Object / Geometry selecting
 

 

 

Hold down the G key:
Information will be displayed in the Status Panel about the Object under the mouse pointer.

Figure 3.2.1. Status-panel while the pointer is “hovering” over an object and the G key
is held down. The Object / Geometry type is identified and options displayed.

To select, click with the indicated mouse button.
Selected Objects / Geometries are shown with torquoise (green-blue) wireframe and with
points visible (Mesh Vertices, Spline CVs etc.).

You can also “drag-select” Objects, by holding down the G key, holding down a mouse
button and moving the mouse to select a rectangular area.

Figure  3.2.1.  Drag-selecting  Objects  (Spline  Faces,  in  this  case).
Torquoise wireframe shows that  Objects of  a Model  are selected (vs.
white wireframe for selected Models).
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If the Object under the pointer is a Camera or a Light, you are only offered one option: to
select the Object.

If the Object under the pointer is a Mesh, you can select either:
• The entire Mesh

• The PolyGroup under the pointer.

• The Polygon under the pointer. In this mode, holding down the right button while
moving the pointer will “paint-select” (or unselect, if started on a selected Polygon)
the Polygons under the pointer.

• The Edge under the pointer. “Paint select” also works for Edges.

Figure 3.2.2. Polygons selected with "Paint-select". 
Note that selected Polygons are highlighted with red, but the original
surface will show through (including textures and reflections).

When PolyGroups of a Mesh is selected (vs. the entire Mesh), the Vertices of the Mesh are
not  shown (unless  you  are  in  “Edit  Polygons”  mode).  This  is  how you  can  tell  the
difference!

In 'Solid' display modes (as opposed to wireframe), when selecting, a ray is cast through
the scene, and the intersection between this ray and the closest surface (closest "hit") is
selected.

In the preferences dialog box,  an option can be set to limit ray-intersect testing to the
selected objects when performing this kind of selecting. This can be useful for example to
select Polygons on an object behind an unselected object. It could also mean a significant
speedup when selecting Polygons in "Polygon paint-select" mode.
Selected Polygons are highlighted in "solid" display modes (this is optional, see "Display
controls").
The highlight is blended with the surface, so shading and textures show through as fig.
3.2.2. illustrates.
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3.2.1. Polygon “fill-select”
 

 

 

Hold down the  L key and move the pointer over a Mesh. You will be able to select all
Polygons that are connected to the one under the pointer, within the PolyGroup, or in the
entire Mesh, or all PolyGroups connected to the one under the pointer.
A Polygon is considered connected to another, if it is reachable via shared Edges.

This tool is incredibly useful when you have Meshes with large numbers of Polygons.
For  example,  you  may get  a  Mesh from someone,  that  has thousands,  or  millions of
Polygons, containing several parts, all merged into a single PolyGroup, and you want to
split them apart, so you can assign different Materials to them.
Selecting Polygons one-by-one, or even via paint-select, could be extremely tedious. With
fill-select, it will take a single click.
See also:
Menu->Geometry->Separate Polygons
Menu->Geometry->Separate PolGroups
etc.
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If the Geometry under the pointer is a Spline, you can select:
– the Spline itself (Geometry), or
– the Spline Segment under the pointer

Figure 3.2.2. Splines with one segment selected

Multiple Geometries or sub-geometries (PolyGroups or Spline Segments) may be selected
by holding down Shift+G.
Clicking on 'nothing' while in single Geometry selection mode (no Shift key) will unselect
every Geometry or PolyGroup in the Scene.
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3.3. Selecting Points
 

 

 

Hold down the 'T' key and drag the mouse with one of its 3 buttons pressed. This will draw
a rectangular area in which points are tagged (selected), un-tagged or the tags are inverted
when you release the  mouse button.
The Status Panel will explain the function of each mouse button.

 

Figure 3.3.1. Tagging points of a Mesh and a (Bezier) Spline

Another way to select points:
– select Polygons on a Mesh/PolyGroup as described before
– go to: Menu->Select->Tag Vertices of selected Polygons.

To un-tag all points of the selected objects, go to: Menu->Select->Un-tag all vertices.

Once points are tagged, you can transform them by selecting “Tag” in the Transform panel.
and activating Scaling, Rotation or Translation. See figure 3.3.2.

 
Figure 3.3.2. Rotating Vertices of a Mesh
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4. Basic Geometry editing
 

 

4.1. Undo / redo
 

 

 

EQUINOX-3D  has  unlimited,  comprehensive  undo  and  redo,  so  you  can  experiment
freely!
You can use the common key combinations:
- Ctrl-Z : undo last operation
- Ctrl-Y : redo last operation
Or, you can go to Menu->Edit->Undo / Menu->Edit->Redo.
There's also  a  “trademark” undo stack indicator  in the  StatusBar.  Empty  means there,
nothing to undo, full blue means you have reached the user-settable maximum undo steps,
so the oldest operations will get deleted as you go.
You can set this maximum to anything. The only limitation is how much memory your
computer has.

4.2. Construction history
 

 

 

In EQUINOX-3D, Geometries, Models etc. can "remember" how they were created. This
is called construction history. This information is kept when you save a Scene into a file.
For example: create a torus and close the Torus dialog box.
This torus is represented as a Polygon Mesh, but EQUINOX-3D will remember that it was
created by the 'Torus" plugin. This plugin can re-build the torus with different parameters.

If you want to, say change the main radius of the torus, just:
– select the torus Geometry (G key + Left Mouse button)
– press E to edit the parameters again (radius, number of subdivisions etc. )

Construction history may have other Objects as inputs and multiple levels / steps.
For example, you may build the profile shape of half of an object as a Spline, extrude that
Spline to create a Mesh, then Mirror the resulting Mesh, to create the other half.
If you modify the Spline, it will make the extruded Mesh update, which will make the
mirrored Mesh update, and so on.

This is an incredibly powerful system. It allows you to set up “dependencies” only once,
then, when you edit the input shapes, all the dependent shapes will be rebuilt automatically.
It makes advanced 3D design and CAD work easy and thousands of  times faster than
modifying everything by hand.
It also allows you to match / fit parts perfectly.
For example, you can use the same Spline both for extruding a shape, and for creating a
rim for a rubber seal on it. Or you can use a Spline to cut a hole in a shape, then place
screws around the hole along a Spline offset from the original Spline by an  exact and
constant distance along the curve.
The possibilities are endless!



 38

4.2. Editing shapes
 

 

 

The easiest way to edit Geometries is to move their points (the control-vertex of a Spline or
a Vertex of a Polygon Mesh).
To move a single point, activate the "Move point" tool by holding down the M key.
This is also a transient mode tool. As soon as you release the M key, it deactivates and goes
back to the previous mode, so you can quickly select an object, move a few points on it,
select another one etc.
The point being moved becomes active which is indicated by a yellow highlight.

When you create a Bezier spline, its "Previous" and "Next" sub-keys will be at the same
position as the CV itself, so all segments of the Spline will appear linear.
However, when you start moving a point with the Move point tool, it first "pulls apart" the
Previous sub-key, so the segments around the key will become curved.
See Appendix A4: Spline menu for details on creating and editing Splines.

To  scale  /  rotate  /  move  multiple  points,  you  can  select  the  points  and  use  the
TransfomPanel. See 3.3. Selecting points, for more details.
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4.3. Editing the attributes of a Mesh
 

 

 

Select a Mesh by holding down the  G key and press the  E key,  to bring up the Mesh
atrributes dialog box.

Figure 4.3.1 Mesh attributes. Note that the Mesh on the right has a “Box”
construction history. It “remembers” that it's a box. Changing the box pa­
rameters will modify the Mesh.

You may delete the construction history, by clicking the “X” in the top­
right corner of the “Box” drop­down folder.

This will make the Mesh “forget” how it was created, turning it into a
plain Mesh.
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4.4. Editing the attributes of a Subdivision surface
 

 

 

To turn a  Mesh into  a  subdivsion  surface,  select  the  Mesh and click  Tool->Surface-
>Subdivision surface. If you right-click, it will also bring up the settings dialog box.

Figure 4.4.1. Subdivision surface. Note the the low-res input Mesh on the right. It is
instantiated under a separate Model, so it can be moved away from the smoothed
Mesh (left).

If you already have a subdivision surface set-up, select a subdivision level Mesh and press
the E key, to bring up the Mesh attributes dialog box.
If a Mesh is a Subdivision surface level, it will have a “Subdivision surface” drop-down
panel. The input Mesh (subdivision “level 0”, also known as the “control Mesh”), will also
have a slider that specifies the number of subdivision levels.

Figure 4.4.2. Subdivision surface attributes on the input Mesh. Note the “Mir­
ror” construction history. Only half of the low­res Mesh was hand­built, it was
then mirrored and smoothed / subdivided by EQUINOX­3D.
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Figure 4.4.3. Subdivision surface attributes on the level­2 Mesh. Note that
EQUINOX­3D   automatically   names   the   subdivision   levels   as   inputMesh­
Name­subdX, where X is the level of subdivision.
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4.5. Editing the attributes of a Spline
 

 

 

Select a Spline, or one of its Segments by holding down the G key. The Spline will turn
torquiuse color. Selected segments turn yellow, as seen on Figure 3.2.2.
Now, go to Menu->Info->Edit on selection, or just press the E' key.
This should bring up the dialog box shown below:

Figure 4.5. Spline attributes dialog box.

If a Spline segment was selected, the current CV (Control Vertex) will be the one at the
beginning of that selected Segment.
Selecting a different segment while the dialog box is up, will automatically update the "CV
and segment information" and it will make the current CV yellow in the 3D views.
This dialog box shows allows you to change attributes of the Spline, such as tesselation
(piecewise-linear approximation) settings and segment types.
EQUINOX-3D lets you change the tesselation per segment. This is very useful when you
use a Spline to create a surface (e.g. with the “Revolve” tool) because it lets you finely
control the number of Polygons in the resulting surface.

There is also a very useful function, called “Shift CVs”:
Often, when you create a Spline, you might not start with the CV you will want to be the
first one.
Sometimes, this does not matter. For example, when a closed Spline is used for modeling.
However, when you want to use a Spline to move the camera along a path, the start and
end points matter, even if the Spline is closed.
The “Shift CVs” tool allows you to “move” the CVs around, forward or backward.
Each CV will preserve its attributes, so the shape of the Spline will not change (unless the
Spline is  open,  in which case the “gap” between the last  and the first  CV will  move
around).
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4.6. Editing the attributes of a Face
 

 

 

Select a Face by holding down the G key and press E:

Figure 4.6.1. Selecting a Face out of 3 Faces on a Model.

Figure 4.6.2. Selecting a hole contour of a Face. Note that the Face
has one instance, but the hole Spline has no instances under Models.
it is only stored on the Face. You can instantiate the contours of a
Face, by clicking “Split contours”.
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4.7. Deleting
 

 

 

Delete selection (Delete key) will:

• Delete selected Polygons in a Mesh/PolyGroup if they are selected as a Geometry or a
PolyGroup.

• If there are no selected Polygons in a (selected) PolyGroup, it will remove the Polygroup
from its Mesh.

• Deleting a single Model, or a Branch of a hierarchy also works.

• Ctrl + Delete will delete selected points (Mesh Vertices, Splinec CVs)

• Shift + Delete will delete selected Edges on selected Meshes
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5. User preferences (settings)
 

 

 

The preferences files are located either in: /usr/local/equinox/.equinox or in .equinox/ from
the user's home directory.
The  main  preferences  file  is  called:  .EQUINOX-3D.  It  stores  the  global  settings  for
EQUINOX-3D, as a user-readable text file.

The  default  settings  for  each  3DWindow  are  stored  in  separate  files,  named
.EQX3DWindow-00, .EQX3DWindow-01 etc.

Plugin preferences are saved in separate files, specified by the plugins. These files are
saved in the same directory where the main prefs file was found when EQUINOX-3D was
started.
Plugins can define a list of "Resources" (variables with type information) and these are all
automatically saved into the appropriate files when the user selects "Save preferences".



 46

Appendix A - summary of menus
 

 

 

A.1. Select

Selection functions 

This menu contains several functions, such as Select All Models, all Meshes, Eges with
selected Vertices, and so on. The names are self-explanatory.

A.2. Information

A.2.1. Edit selection (hot key: 'E'):

Finds the first selected object in the Scene and pops up a dialog box, to edit the attributes
of that object.
This may be a Model, a Geometry (Mesh, Spline etc.), a PolyGroup or many other things.

Remove attributes (hot key: 'Alt+Del'):
Remove extra information, such as construction history from the selected Geometries and
Models.



47 

A.3. Camera

Zoom into region

Select a rectangular region on a 2D view (top, front, right, schematics, etc.) to zoom into.
Also, see camera controls.

Add Camera-dependence to Model

Allows you to make a Model only visible to a particular Camera, or sub-camera (left / right
eye for 3D stereo).
This  is  very  useful  for  VR.  For  example,  if  you  want  to  feed  live  3D  video  into
EQUINOX-3D and you want to display it in your VR headset, mixed with virtual 3D
objects (augmented reality, or remote reality, if you are using EQUINOX-3D to drive a
robot with 3D vision).

Add / edit background image

Allows you to add an image file as the background for a particular Camera, for example if
you want to use a reference image while building a 3D model.

Reset

Resets / flies the Camera of the current 3DWindow, or all windows to the default position.
Also, see camera controls.

Frame all

Moves /  flies the Camera into  a position that allows convenient viewing and orbiting
around all visible objects in the Scene.
Also, see camera controls.

Frame selection

Moves /  flies the Camera into  a position that allows convenient viewing and orbiting
around the selected objects.
Also, see camera controls.
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A.4. Spline / Face

Close and Open

Close or open the selected Splines.

Draw Linear

Create a Linear Spline by adding CVs. When a new CV is created, it can be moved right
away without releasing the mouse button.
A new CV can be added after the last one, before the first one or between two existing ones
(the tool finds the closest point on the Spline).
For a description of the different Spline types, see section: 2.1.2.

Draw Bezier

Create a Bezier Spline by adding CVs. When a new CV is created, the handles can be
pulled apart right away without releasing the mouse button.
A new CV can be added after the last one, before the first one or between two existing ones
(the tool finds the closest point on the Spline).
If you add a new CV before the first one, this will pull out the "Previous" side of the
handle. For "after" and "between" CVs, it pulls out the "Next" side.
This also works in the "Add point" tool.

Draw BSpline

Create a B-Spline by adding CVs. When a new CV is created, it can be moved right away
without releasing the mouse button.
A new CV can be added after the last one, before the first one or between two existing ones
(the tool finds the closest point between the CVs).

Draw Cardinal

Create a Cardinal Spline by adding CVs. When a new CV is created, it can be moved right
away without releasing the mouse button.
A new CV can be added after the last one, before the first one or between two existing ones
(the tool finds the closest point on the Spline).

Edit points

Add new CVs to an existing Spline and delete CVs. You need to select a Spline before
activating this tool.  When a  new CV is created,  it  can be  moved  right  away without
releasing the mouse button. A new CV can be added after the last one, before the first one
or between two existing ones (the tool automatically finds the closest point on the Spline).
See the Status-panel for details.

Edges to Splines

Takes a Mesh as an input and for every edge of that Mesh, it creates a linear Spline. This
may be useful for extruding a shape (Spline) along those edges to create a manifold shape.
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Linearize

Convert the selected Splines to linear type, by sampling points on curved segments.

Offset Spline

Creates a Spline that is offset from the selected Spline by a constant and exact distance,
through the curve. The offset Spline will have construction history and it may be snapped
to / offset from a surface as well.
This is a very powerful tool.  It allows, for example, to cut a “window” on a complex
surface and place screws along the edge of the window, an exact distance away from the
edge, to create an internal part that fits perfectly on the inside of another part, and so on.

Convert to Face

Convert  the  selected Spline or  Splines  into  Face(s).  The Splines  must  be  closed.  The
resulting Face will have its own copy of the Spline, but the original Spline will be kept as
well.
See Figure A.4.1.

Figure A.4.1. Converting a Spline to a Face

Attach hole to Face

Attaches the selected Spline(s) to  the selected Face(s) as hole(s).  The Splines must  be
closed.
The resulting Face will have its own copy of the Spline(s), and the original Spline(s) will
be kept as well. See Figure A.4.2 for an example.

Figure A.4.2. Adding holes to a Face

Convert Face to Polygon

Converts the selected Face into a Polygon.  This tool  creates a new Model,  Mesh and
Polygroup for this Polygon.
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A.5. Polygon

Edit Polygons

This is an interactive tool. Before activating it, select a PolyGroup to be edited. This tool
lets you perform different operations, incuding:
• Adding new Polygons to a PolyGroup / Mesh

• Adding Vertices on Edges (splitting Edges)

• Adding Edges (splitting Polygons)

• Deleting Edges (merging Polygons)

• Deleting Vertices

This tool is context-sensitive, so the type of applicable operations will depend on what is
under the mouse pointer.
The Status-panel will indicate the valid operations.

Fix Polygon directions

This is an incredibly useful tool  for fixing “messy”  Meshes with inconsistent Polygon
directions.
Polygon  direction  matters  for  several  reasons,  such as  rendering  efficiency (back-face
culling),  fast  closedness  and  containment  tests  (e.g.  for  boolean  operations),  solid
rendering (effectively ray-tracing transparent objects), 3D printing and so on.
A Polygon is considered facing toward you, if its Vertices are in counter-clockwise order,
as seen by you.
Unfortunately,  many 3D applications don't  enforce consistency,  so  you'll  probably see
Meshes with some Polygons facing outward, some inward, often in a seemingly random
way.
This tool will bring all Polygons within connected surfaces (see Polygon fill-select) to the
same orientation.
Once the Polygon directions are consistent, you can easily invert all Polygons, if they are
not facing in the right direction:
- Select a Mesh or PolyGroup and do Menu->Geometry->Invert, to invert them, or:
- Fill-select Polygons and do Menu->Geometry->Invert Polygons
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A.6. Create

Various primitives, such as Circle, Box, Grid, Sphere etc.

These tools create Splines, Meshes etc. with construction history,  so you can edit them
interactively.
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A.7. Surface

Extrude

This tool takes a “profile” Geometry that is either a Spline or a Face and extrudes
it along a straight line, creating a surface (e.g. a Polygon Mesh).

The construction history on the resulting surface allows you, for example to change the
Shape of the profile Spline / Face and the extruded surface will change interactively.
The depth and direction of the extrude can be specified, the front and back faces can be
beveled, the profile may be scaled and rotated through the extrusion (“Twist”), etc. See
settings dialog box below.

  

Figure A.7.1. Extruding a Face with holes. Without bevel and with bevel.

Figure A.7.2. Extrude tool dialog box and an extruded
object with Twist and Scale..
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Extrude Mesh

This tool takes a a Mesh as its input and creates a new Mesh that has a “wall
thickness”, instead of just a surface.

It properly handles boundary Edges and Polygons with holes.  The construction history
allows you to change the thickness, to create only the inside, or the only the sides, to put
either of  those in  separate  PolyGroups  and  so  on.  This tool  is  fundamental  for  solid
modeling. It is essential for creating designs that can be 3D printed, or manufactured in any
other way.  This tool  is  activated by the same button as Extrude.  If you have a Mesh
selected when you click that button, it will do an Extrude Mesh. If you have Splines and/or
Faces selected, it will extrude those.

Figure A.7.3.  Extrude Mesh. Before (left) and after (right). Note the wall thickness in the
right image. The left image has “Double sided” rendering enabled, otherwise the inside of the
Polygons would not be visible (due to back-face culling).

Figure A.7.3. Extrude Mesh settings dialog box.
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Extrude along Spline

This tool  takes  a  “profile”  Geometry that  is  either  a  Spline  or  a  Face and
extrudes it along a “path” Spline, creating a surface (e.g. a Polygon Mesh).

This a very powerful modeling tool that allows you to create complex surfaces from a
couple of Splines. The construction history on the resulting surface allows you to change
the shape of  the profile Spline / Face or the path Spline and the extruded surface will
change interactively.
You can also go back and change the options of the tool by selecting the surface Geometry
and pressing the E key (Menu->Info->Edit on selection).
Figure A.7.2. and A.7.3. show examples of extruding a Spline and a Face along a path
Spline.

Figure A.7.1. Extrude along Spline (“loft') dialog box

Figure A.7.2. Extruding a Spline along another Spline

Figure A.7.3. Extruding a Face with holes along a Spline
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Figure A.7.4.  Extrude and Extrude along Spline, with the optional bevels are very powerful
modeling tools. For example, they allow you to quickly build a couch just from a few Splines.

Extrude along Spline also allows you to vary the size of the cross-section along the path,
by using two “guide” Splines. A 3rd guide Spline allows you to vary the spacing between
the cross-sections.

Figure A.7.5.  Extrude along Spline with scaling “guide” Splines (green), path Spline
(white, selected) and profile Face with a hole.
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Extrude along Spline also allows you to “snap” the resulting shape to a surface.
These features allow for advanced CAD work. For example, you can exactly place cutting
shapes on surfaces, to cut out the hole for the windshield of a car, or the doors on a robot's
skull, add rims for placing rubber seals and so on.

Figure A.7.6. Extrude along Spline with “Snap to surface” option enabled.
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Revolve

This tool  revolves  a Spline (the “profile”) around an arbitrary axis to create a
surface (e.g. a Polygon Mesh).

Typical use:
• Create a Spline and make sure it's selected

• Click on the Revolve icon on the Tool Panel: (left button: no dialog box, right button:
dialog box.), or

• Select  Menu->Surface->Revolve  either the main button or the little dialog box icon
besides it.

Dialog box options:
• Triangles: the resulting surface will be made of triangles or rectangles

• Smoothing angle: average the normal vectors at the Polygon Vertices to create a smooth
surface appearance

• Start and End angle: it allows for a non-complete (less than 360°) revolution.

• Sides: the number of sides on the surface

The tool maintains a construction history, so you can change the shape or the parameters of
the profile Spline at any time and the surface will change interactively.
You can also go back and change the options of the tool by selecting the surface Geometry
and activating Menu->Info->Edit on selection.

Note: make sure that the contour Spline is drawn counter-clockwise and to the right of the
Y axis, as seen on the Front view, otherwise the revolved surface will be inside-out.

Figure A.6.1. Revolving a Spline
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Skin

This tool  “stretches” a surface on a set of a Splines (the “cross-sections”), much
like the skin of an airplane wing covers the “ribs”.

– Create a set of Splines and make sure they are selected
– Click on the Skin icon on the Tool Panel: (left button: no dialog box,  right button:

dialog box.), or
– Select   Menu->Surface->Skin  either the  main  button  or  the  little  dialog box  icon

besides it.

Dialog box options:
– Triangles: the resulting surface will be made of triangles or rectangles
– Smooth:  average  the  normal  vectors  at  the  vertices  to  create  a  smooth  surface

appearance
– Weld closed cross-section ends: merge the two Vertices on the surface that correspond

to the beginning and the end of a closed Spline cross-section
– Sides: the number of steps along the cross-section Splines

The tool maintains a construction history, so you can edit the cross-section Splines, change
the Skin parameters etc., and the surface will change interactively.
You can also go back and change the options of the tool by selecting the surface Geometry
and activating Menu->Info->Edit on selection.
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Subdivision surface

Converts a Mesh to a subdivision surface. For details, see:
2.3.2. Subdivision surfaces, and
4.3. Editing the attributes of a Subdivision surface
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A.8. Geometry

Tesselate

This tool converts all "complex" Polygons in the selected Meshes into triangles. A complex
Polygon is one that is either concave or has holes in it.

Triangulate

Converts all Polygons in the selected Meshes into triangles. This might be necessary when
using a 3D object in a real-time renderer (such as in a 3D video game), as most of those
renderers only support triangles.
In EQUINOX-3D, Polygons can have any number of sides, they can be concave or even
have holes on them.

Un-triangulate

Merges  triangles  of  the  selected  Mesh,  by  automatically finding  Edges  that  could  be
deleted. This tool only selects those Edges, so you can see them select/unselect further
Edges, before deleting them.
To delete the selected Edges, press Shift + Delete.
This tool is incredibly useful, if you get some 3D models as triangle Meshes, but you want
to edit them (e.g. turn them into subdivision surfaces). Editing models as triangle Meshes is
very tedious, and this tool makes it much easier for you to convert them to quad, or n-gon
Meshes.

Separate Geometries

Collects all the selected Geometries (Meshes, Splines etc.) and move them into a newly
created Model.

Separate PolyGroups

Collects all the selected PolyGroups within a Mesh and move them into a newly created
Mesh.

Separate Polygons

Collects all the selected Polygons within a PolyGroup and move them into a newly created
PolyGroup.
This allows for assigning and changing a common Material on these Polygons.
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A.9. FX

Merge Splines 

Merge selected instances of Splines into a single Spline, by automatically finding the
closest points between them.

This tool is essential for a lot of 3D modeling and CAD operations. For example, you may
want  to  merge  exact  circular  arcs,  with straight  lines and Bezier  curves.  Construction
history allows you to change the radius of  the arc later, or  edit any of  the other input
Splines while the merged result will change interactively.

You can use multiple instances of the same Spline, as inputs.
For example, you only have to create the Spline profile of a single step, in flight of stairs,
duplicate / instance them with the Clone with repeat tool, then you can merge the results
into a single Spline, to create the stairs with the  Extrude or  Extrude along Spline tool
(use the latter, if you want curved stairs, such as at the entrance of an opera house).

You can add / remove input Splines later, temporarily deactivate some of them (so you can
see things more clearly), sort the inputs by Model or Spline, etc.

        A.9.1. Merge Splines dialog box.
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Merge Meshes 

Create a single Mesh from instances of multiple Meshes.

This tool is extremely useful, for many purposes, such as for building a single Mesh, to be
used for 3D printing, or other forms of physical prototyping / manufacturing.

It's also great for simplifying your Scene and speeding up some operations. For example, if
you want to cut multiple pieces from a shape (say, 10 screw holes) with the Boolean tool,
as  long as  the  pieces  don't  intersect,  you  can merge  them and perform only a  single
Boolean operation.
This will keep your hierarchies simpler (only one Boolean result Mesh vs. one for each
cutting piece) and make the boolenan operations faster. This is because merging Meshes is
a lot simpler and faster than a Boolean operation (no intersection tests etc.).

You  can  also  merge  any  Vertices  that  are  within  a  given  distance,  and  /  or  merge
PolyGroups that use the same Material.
This is very useful for optimal content video game / VR scenes etc. Merging many parts
into a single PolyGroup, and doing a single, optimized texture layout (see Edit PolyGroups
dialog box), allows you to render a single light map texture for the merged models.
This will allow you application to draw all of these models with a single API call, greatly
improving rendering performance.

You can use multiple instances of the same Mesh, as inputs.

You can add / remove input Meshes later, temporarily deactivate some of them (so you can
see things more clearly), sort the inputs by Model or Mesh, etc.

 A.9.2. Merge Meshes dialog box.
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A.10. Clone

Immediate

Create a clone (copy) of the selected Models, including their Geometries.
If only Geometries are selected on a Model, this tool creates a new Model and adds a
duplicate of each selected Geometry to this new Model.
If only PolyGroups are selected, new Meshes and Models will be created accordingly.

Options
 

Duplicate shares Materials If this  option is selected (default),  the new Geometries
will share Materials with the originals, so the Materials
can be edited simultaneously.
Otherwise each new Geometry will have its own copy of
the Materials it is using.

Clone construction history If this  option is selected (default),  the new Geometries
will  have  a  copy  of  the  construction  history  of  the
originals.

New instance

Create copies of the selected Models, but instead of making copies of their Geometries,
those will be shared between the original Model and the new one.
When a shared Geometry changes (e.g. when you move a Vertex of a Mesh), all of its
instances will change simultaneously.
This allows for creating copies of objects, placing and orienting them and later editing their
shape all at once without having to copy and position them again.
Instancing can also save a significant amount of memory, as only one copy of the instanced
Geometry will need be stored.
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Duplicate with repeat / Over shape

Create copies or instances of Models / Objects with incremental transforms, or along a
shape, like a Spline or the surface of a Mesh.
There are separate menu buttons, for “With repeat” and “Over shape”, but it's the same
tool. You can, in fact switch back-and-forth in the dialog box.
For example, make 5 copies, each rotated by 20 degrees and moved by 0.5 units along the
X axis.
When duplicating along a Spline, you can also scale the copies and control the distribution
of the copies, via additional “guide” Splines, similarly to the Extrude along Spline tool.
This tool is essential for modeling anything repetitive, such as a spiral staircase, a space
station hallway, made of blocks, for placing, say 10x10 holes on in a grid for a speaker,
and so on.
For example, it allows you to create the tracks for a bulldozer, or the metal chain wrist
band of a watch.

Figure  A.10.1  Duplicate  with  repeat,  along  a  Spline.  The  tracks'  overall  shape  was
modeled with a Bezier Spline and a model of a link was cloned 33 times, along this Spline.

Figure A.10.2 Duplicate with repeat, along a Spline, with X and Y scaling guide Splines.
The path Spline is shown as Model-selected (white) and the guides are Objec-selected
(torquoise). You can also see the original shape, next to the copied ones.
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Mirror

This tool is essential for building anything symmetrical (cars, airplanes, people etc.). It will
literally cut the work you have to do in half!
You only need to model one side of a Spline, or a Mesh and this tool will build a mirrored
version, with both sides.
As you edit the original side, it will interactively rebuild the mirrored side.
It can also merge or remove points on the seam, creating a smooth / seamless shape. 
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A.11. Delete

Deleting tools

Tools for deleting Models, Objects, Animations etc. Live (almost) everything else, deleting
is, of course, undoable.
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A.12. Transform

Reset

Set the transformation values of the selected Model(s) to:
 Scaling: 1.0, 1.0, 1.0
 Rotation 0.0, 0.0, 0.0
 Translation: 0.0, 0.0, 0.0

Freeze to world

Perform the local-to-world transformation of every Geometry in the selected hierarchies
and reset the transformation values of the Models in those hierarchies.
This effectively puts the origins of the local coordinate systems of every affected Model
into the world origin. The position of the objects will remain the same.

Freeze branch to its parent

Perform the local-to-branch-parent transformation of every Geometry in the Models of  the
selected branches. 
This puts the origins of  the local coordinate systems of  every affected Model  into the
origin of the parent of the branch root, and resets their local transformations.
If the branch-root has no parent (it is the root of the hierarchy), this operation is equivalent
to “Freeze to world”.

Freeze branch to its root

Perform the local-to-branch transformation of every Geometry in the descendant Models in
the selected branches. 
This puts the origins of  the local coordinate systems of  every affected Model  into the
origin of the branch root, and resetting the local transformations.

Freeze scaling on branch

Perform  the  local-to-branch  scaling  of  every  Geometry  in  the  descendant  Models
descendant Models in  the selected branches.
This operation is similar to “Freeze branch to its root”, but it only affects the scaling
values.
All the affected Models will have a scaling of: 1.0, 1.0, 1.0, but will retain their original
shape.

Snap tagged points to grid

Move all tagged points to the closest grid cell. The grid settings used are of the main 3D
window (usually top-right).
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A.13. Hierarchy  

Connect 

Connect a Model or a branch to a parent Model to make a hierarchy. You need to
select a Model or a hierarchy branch before activating this tool.

You can pick a parent or a child for the selected Model. You can connect multiple selected
Models to a parent at once. Of course, if you pick a child for a 'parent to be' Model, you
should have only one Model selected.

Disconnect

Disconnect the selected Model(s), branch(es) or Objects from their a parents. 

Move (reparent) 

Move Models, branches of a hierarchy, or Objects to under a new parent.

Collapse branch

Collects all the Objects from the Models in a branch (hierarchy sub-tree), then
– performs the appropriate transformations on them
– adds the Objects to the root Model of the branch-
– then removes all descendant Models from the branch root

Example:

The Model, called “Tube” will contain the tube, sphere and capsule Objects. The 3 Objects
will now all use the same transforms, defined by “Tube”.
However, their shape was modified by the collapse tool to compensate for the different
transforms (the Vertices of the Meshes were transformed the “opposite way”), so the 3D
view will look the same after the operation.
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A.14. Material

Add / edit on selection

Edit the Material of the selected objects (Models, Geometries etc.). This tool first checks if
any of the selected PolyGroups / Meshes, or Models have a Material. If they do, it assigns
the Material from the first such object, to all selected ones, then pops up the dialog box.
If none of the selected objects has a Material, the tool creates a new Material and assigns
that to all selected objects, before poping up the dialog box.
If an object has no Material of its own, but is in a hierarchy, it will inherit a Material from
its parent or its parent's parent etc. This inheriting is automatically updated when a Model
is connected or disconnected from a hierarchy.

Figure A.14.1. Material dialog box.

EQUINOX-3D has a physically-based, photorealistic renderer and it comes with several
physically-based Materials (metals, dielectrics etc.).
Materials are fully programmable and plugins may implement new types of Materials.
Material colors may be specified either as RGB, or in a hyper-spectral form, that allows for
more accurate, full spectral rendering. For example, it allows for simulating diffraction in a
prism and the resulting “rainbow” spectrum (the hyperspectral renderer is not released yet).
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Assign from another object

Assign (share) the Material of another object to all selected PolyGroups. You can also pick
the Material to be shared from the Material lister.

Copy from another object

Copy the Material of another object to all selected PolyGroups.
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A.15. Render

Rendering tools

While  EQUINOX-3D allows you  to  switch any 3DWindow into  any rendering-mode,
including  full  global-illumination  ray-tracing,  you  can  also  open  a  separate  rendering
window and set up rendering of movies here (start frame, end frame, output file name etc.).
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A.16. Animation

Path animation

Animate an object along a path defined by a Spline.
Example:
  - Create a Spline (for this tool, only Bezier or Linear are supported at the moment).
  - Create, say a cube
  - Select the cube
  - Activate Animation->Simple path animation
  - The message on the Status Panel will ask you to pick a path, click on the Spline
  - Hit PLAY on the Time Panel

If you close the spline and turn on looping in the Time Panel, the cube will keep flying
around the closed path.
Since there is no function-curve editing yet, this tool simply assigns the start and end frame
set in the Time Panel for the starting and ending point of the path.
For a closed path, you can try the example file:
 Examples/Animation/Path/FunkyPath.hrc

For  the technically inclined:  this  tool  uses  correct  arc-length  parameterization on  the
Spline, so objects will move at an even speed regardless of the shape of the Spline.
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Appendix B
 

 

 

Glossary

Construction history A high level description of a Geometry, Model etc.. It describes how
that object was created, potentailly depending on other objects.
This lets the user edit a Geometry at a higher level than its physical
representation (e.g. a Polygon Mesh). For example, simply changing
the radius of a sphere (e.g. by moving a slider), the user can have the
"Sphere  tool"  re-build  a  different  polygonal  approximation  of  a
sphere.

CV Control Vertex, also known as Spline Key. A point of a Spline that
affects the shape of that Spline.

Geometry A type of point-list, line, surface or volume that represents a shape.
EQUINOX-3D supporst the following Geometry types:

– Point set
– Spline (Linear, B-Spline, Bezier and Cardinal)
– Face (flat surface defined by Splines)
– Polygon Mesh

Material The description of a surface and internal properties of an Object that
(along with  the shape) makes it possible to render an image of that
Object,  or  for  other  Objects  to  interact  with  this  Object  (physics
simulation).
Material descriptions may range from a single color, or the traditional
Ambient/Diffuse/Specular colors (plus transparency, refractive index
etc.)  to  complex,  physically-based  models  that  describe how light
interacts with a certain Object.  Materials may contain  textures and
shaders.

Mesh Also called Polygon Mesh. A type of Geometry that has an array of
points  (Vertices)  and  Groups  of  Polygons  (PolyGroups).  The
Polygons index the Vertices from the array on the Mesh.

Model Also called transformation-node or transform-node: the element that
“brings” (instantiates) Objects into the scene and defines their size,
orientation and location in world-space.

Object-space Also called local-space: the coordinate system in which the shape of
an Object is defined.
The relationship between the  local-space of that Object and  world-
space is specified by the Model(s) that instantiate that Object,  via
coordinate-system transformations (scale, rotate, translate).

PolyGroup A group  of  Polygons  in  a  Mesh  that  share  a  Material  (and  its
Textures).

Plugin A piece of  software (program and  data)  that  can be  inserted  and
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removed from an application while the application is running.
Plugins allow anyone with programming knowledge and familiarity
with  the  API  (Application  Programming  Interface)  of  a  particular
application to add custom functions without needing to re-build the
whole application.
EQUINOX-3D has a  relatively small  core  and a large number  of
plugins, providing flexibility and scalability.

Shader A mathematical model that simulates a light-surface or light-volume
interaction and its program implementation. Shaders are associated
with Materials.
In  addition  to  the  built-in  shaders,  such  as  “Lambert”,  “Phong”,
“Blinn”,  “Ward's  anisotropic”,  EQUINOX-3D  also  has  a
programmable shader interface. People familiar with basic computer
rendering can implement their own shaders in a plugin and use them
in the ray-tracer (you don't need to understand how the whole ray-
tracer works). For example: a physically correct skin or hair shader.

StatusPanel A horizontal bar that displays information about the current state of
EQUINOX-3D.  These include  the function  of  the  mouse  buttons,
undo stack indicator and the time code for the current frame.

Transformation An operation to  convert an Object  from one coordinate-system to
another.  Usually  consisting  of  scaling,  rotating  or  translating
(moving). See: Model.  EQUINOX-3D supports an arbitrary list of
transforms per Model.

World-space Also  called  global-space:  the  common coordinate  system  that
defines a 3D scene. See local-space.
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Appendix C

Abbreviations
 LMB - Left Mouse Button
 MMB - Middle Mouse Button
 RMB - Right Mouse Button
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